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Operation of Irrigation GIS in the Data and Information Management Unit 
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ON 

THE NATIONAL IRRIGATION MASTER PLAN 

IN THE UNITED REPUBLIC OF TANZANIA 

 
Operation Manual 

for  
Simple Database and Information System 

 
1 Introduction 

(1) Authority 

This operation manual has been prepared as a product of the Verification 
Study stipulated in the Scope of Work for the Study agreed between the 
Ministry of Agriculture and Food Security, the United Republic of Tanzania 
(MAFS) and the Japan International Cooperation Agency (JICA) on April 10, 
2001.  

(2) Background and Objective of Establishment of Database System 

(a) Background 

In the Master Plan and Action Plan Studies, lots of data, reports and 
topographic maps necessary for irrigation development have been collected. 
The results of the inventory survey are an important collection of data.  It 
is expected that those data will continue to be accumulated and will be fully 
utilized for irrigation development.  If systematically kept in one place and 
made easily retrievable, these data will be extremely valuable for planning 
irrigation development by DITS of MAFS and District Offices.  

Currently, development of most irrigation schemes is in the hands of the 
District Offices in line with the decentralization policy.  Even under this 
situation, DITS of MAFS should take control of ensuring that irrigation 
development in the country progresses on schedule. This means the need for 
timely exchange of collected data on irrigation development between DITS 
and District Offices. The data also need to be stored in the same place and 
to be available for ready access by DITS of MAFS at any time. 

The database system has the functions mentioned above and is, therefore, 
extremely helpful for the management of irrigation development by not only 
DITS of MAFS but also District Offices.  
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1 Introduction 

(b) Objective 

The objective of the database system to be established is to manage data 
and information necessary for irrigation development through the 
establishment of a computerized storage and retrieval system at DITS of 
MAFS.  

(3) Objective and Composition of this Operation Manual   

(a) Objective 

The objective of this operation manual is to fully describe how to use 
the database and information system. 

(b) Composition 

The Operation Manual consists of two parts: (a) Irrigation Database and  
(b) Irrigation GIS.  The Irrigation Database is divided into three functions: 
Irrigation Scheme Profiles, Reference Documents and Topographic Maps.  
The Irrigation GIS is divided into four functions: General Features, 
Protected Areas, Agro-ecological Zones and Land Use (see Figure below). 
The operation of each function is explained in the following sections. 

Simple Database and Information System

Irrigation Database Irrigation GIS

Irrigation Scheme Profiles

Reference Documents

Topographic Maps

General Features
(Administrative boundaries, Rivers, Roads, etc.)

Protected Areas
(National Park, Game Reserve,Conservation Area, etc)

Agro-ecological Zone

Land Use
(Land Cover, Lnad Unit and Soil Type)

Composition of Simple Database and Information System
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Topographic Maps
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(1) General 
 

2 Irrigation Database 

(1) General 

(a) Purpose of Database Development 

There are numerous existing and proposed irrigation schemes in Tanzania. It is 
difficult for the government to manage the large amount of data and 
information on irrigation schemes. To facilitate smooth data and information 
management for irrigation development, the “Irrigation Database” was 
established. 

(b) Basic Concept of Database Development 

The database was prepared based on the following basic concept: 
i) To contribute to easier future maintenance, the database should be prepared 

using the most popular database software in Tanzania, which is “Microsoft 
Access”. 

ii) To accommodate database operation by people with little knowledge about 
Microsoft Access, the database should be operated by ‘user friendly’ operation 
panels. 

(c) Functions of the Database 

The database has three major functions, which are: 
i) “Irrigation development monitoring” function to search and browse irrigation 

scheme development status, 
ii) “Reference documents” function to search and find reference documents for 

irrigation development, and 
iii) “Topographic maps” function to search and obtain electronic topographic maps. 

(d) Combination Usage with Irrigation GIS 

In general, “Irrigation Database” provides numerical and text data on irrigation 
schemes. On the other hand, “Irrigation GIS” supplies geographical data. It is 
desirable for the user to obtain both types of data using “Database” and “GIS” 
in combination. 

(e) Effective Usage of the Database 

The database should be used at all stages of irrigation development, to confirm 
past study results, and to obtain related information for any reason. The 
effective usage of database in the respective stages of irrigation development 
is illustrated in next page. 
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2 Irrigation Database 
 

 
 

Quick Site Inspection

Process of Irrigation Development Usage of the Database

Enter the results of Quick Site
Inspection into the Database
using "Irrigation Development

Monitoring" function

1) result of
inventory survey

2) result of quick site
inspection

Search and find the results of
Inventory Survey using
"Irrigation Development
Monitoring" function

before starting quick site
inspection

after completion of quick
site inspection

before starting
preliminary planning

timing of operation

2) result of
quick site
inspection

Preliminary Planning
with topographical maps and

reference documents

Enter the results of Preliminary
Planning into the Database

using "Irrigation Development
Monitoring" function

2) result of quick
site inspection

Search and find the results of
Preliminary Planning using
"Irrigation Development
Monitoring" function

after completion of
preliminary planning

before starting F/S, D/D
and construction

5) result of
preliminary planning

5) result of
preliminary

planning

F/S, D/D and Construction
with preliminary planning result

5) result of
preliminary planning

Enter the results of Completion
Status into the Database using

"Irrigation Development
Monitoring" function6) completion status

Search and find the Completion
Status using "Irrigation
Development Monitoring"

function

6) completion
status

upon the project
completion

after the project
completion

Search and obtain
topographical maps using

"Topographical Maps" function

3) topographical
maps

4) reference
documents

Search and obtain the
Reference Documents using
"Reference Documents" function

before starting
preliminary planning

throughout the preliminary
planning

Search and find the results of
Inventory Survey using
"Irrigation Development
Monitoring" function
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(2) Irrigation Development Monitoring 
 

(2) Irrigation Development Monitoring 

 Data Input (p.2-3 to p.2-7) 

anel 00 Main Menu (will appear as soon as the database is executed)
 
P  

 

 
anel 01P  

 
 

 

 
 After choosing “Result of Inventory Survey”, 

‘Data Inquiry’ command button comes to be active. 
If you choose “Present Condition and Latest 
Development Plan”, both of ‘Data Input’ and ‘Data 
Inquiry’ command buttons are activated. 

Click here if you want to 
go back to Panel 00. 

First, choose one of the 
data types 

To start using “Irrigation 
Development Monitoring” 

(1) 

function, click here to go 
to Panel 01. 
T  start data input, 
click here to go to 

o
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Panel 01-01. 

(2) 



2 Irrigation Database 
 

Panel 01-01 
 

Choose one of the 
ions.  opt

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to go to 
next record. 

Click h y 
e

e careful to operate this 

eleted)! 

ere and press “Delete” ke
te the record. to del

(B
function since the date is not 
retrieval once it is d

Click here to jump to 
the last record. 

Click here to enter the data 
for a new record
of preliminary planning 

 

 (scheme) 

result. Please make sure 
that the new record has not
already been entered. 

Click h
previou

Click here to go back to 
Panel 01. 

ere to go back to 
s record. 

Click here to go to 
Panel 01-02 to continue 
data input for the 
selected irrigation 
scheme. 

Enter the data 
as numbers 
(numerical data 

Click here and 
choose one of 
the options 
from the drop 
down list. 

Type the data 
as text (text 
data type). 

(3) 

type). 

(2) 
Type the data as 
text (text data 
type). 
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(2) Irrigation Development Monitoring 
 

(2) Irrigation Development Monitoring 
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Panel 01-02 

 
 

 

 
 
 
 
 

Click here to go 
back to Panel 
01-01. 

Click here to go to Panel 
01-03 to continue data 
input for the selected 
irrigation scheme. 

(4) 

Enter the data as date 
(date data type). 

Type the data as text 
(text data type). 

Type the data as 
numbers (numerical 
data type). 

Enter the data as text 
(text data type). 

Choose one option. (3) 

Check if it is 
required. 
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2 Irrigation Database 
 

Panel 01-03 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to go back 
to Panel 01-02. 

(4) 

Enter the data 
as numbers 
(numerical data 
type). 

Choose one. Type the data as 
xt data 

type). 
text (te

Check if it is 
required. 

Enter the data as date 
(d
“d

ate data type, 
d/mm/yyyy”). 

Enter the data as 
r (nume

ata type). 

Enter the data as 
numbers (numer
data type). 

ical Choose one. 

(End of the operation) 

numbe
d

Check if it is 
required. 

rical 
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(2) Irrigation Development Monitoring 
 

Special Consid

. Necessit

er a Inp

resent Ir rea 
The pre tion the 
present irrigated area is smaller than the developm d be 
confirmed. The probable reasons are: 
- The scheme is being developed by stage (phase) wis
- Development is incomplete due to some reason. 
- heme was once fully developed but some areas abandoned for so

 
2. Careful Input for Scheme Area. 
The scheme might have been split to s l schemes eme 
formu . Data on those schemes should y 
on total potential area. 
 
Example-1

ation on Dat

rigated A

ut 

1 y to Confirm P
sent condition screen shows the status of irriga development. If 

ent area, the reason shoul

e. 

The sc me 
reason. 

evera  in the process of sch
lation be input carefully to ensure consistenc

 
A scheme is to B and C scheme and the names changed. 

hould ld be 
newly regis d) 

A scheme village plan 
Preliminary planning sta B scheme DADP 50 ha (applied for DADP) 

e n  applied) 
e a eloped) 

xample-2

 split in
(in this case data on A scheme s  be deleted and B and C scheme shou

tere
Quick inspection stage 300 ha 

ge 
  

 
C schem
(C schem

village pla
rea still has potential to be dev

250 ha (not
 
E  

eme was decreased but remaining area still has potential. 
n this case area of A scheme should be revised and newly register B scheme) 
uick inspection stage A scheme village plan 300 ha 

reliminary planning stage A scheme DADP 50 ha (applied for DADP) 
 B scheme village plan 250 ha (not applied) 
 (B scheme area still has potential to be developed) 

xample-3

Area of A sch
(i
Q
P
 
 
E  

rea of A scheme was decreased and remaining area is not going to be developed. 
n this case area of A scheme should be simply revised) 
uick inspection stage A scheme village plan 300 ha 

Preliminary planning stage A scheme DADP 50 ha (applied for DADP) 
  (remaining area is not going to be developed) 

A
(i
Q
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2 Irrigation Database 
 

 -8 to p.2-12) Data Editing (p.2

 
Panel 00 Main Menu (will appear as soon as the database is executed) 

 

anel 01
 
P  

 
 
 
 
 
 

After choosing inventory survey stage, Data 
Inquiry comm nd button becomes active. In casea  
of choosing “Present Condition and the Latest 
Development Plan”, both Data Input and Data 
Inquiry command buttons are activated. 

Click here if you want to 
go back to Panel 00. 

First, choose one of the 
data types 

To start data editing, 
click here to go to 
Panel 01-01. 

(2) 

To start using “Irrigation 
Development Monitoring” 
function, click here to go 
to Panel 01. 

(1) 
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(2) Irrigation Development Monitoring 
 

Panel 01-01 

 

(2) 

 
 
anel 01-05P  

 

Click here if you want to 
go back to Panel 01. 

Before editing
here to choose target 
irrigation sche

 the data, click 

me. 

(3) 

Click the “down 
arrow” and 
choose one of 
the options 
from the Zone. 

Click here to go 
to the panel 
01-06. 

 Click her
go b

e if you want to 
ack to Panel 01-01. 

(4)
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2 Irrigation Database 
 

Panel 01-01 

 
 

 
Cho

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to go to 
next record. 

Click here to jump to 
the last record. 

ose one of the 
candidates. (4) 

Type the data as 
text (text data 
type). 

Click here and 
choose one of 
the options. 

Type the data 
as text (text 
data type). 

Enter the data 
by number 
(numerical data 

). type

Click here and press “Delete” key 
to delete the record. 
(Be careful to operate this 
function since the date
retrieval once it is de

 is not 
leted)! 

Click here to enter the data 
for new record (scheme) of 
preliminary planning result. 
Please make sure that the 
new record has not already 
been entered. 

Click here to go back to 
previous record. 

Click here to go back to 
Panel 01. 

Click here to go to 
Pa inue 
data input for the 
selected irrigation 
scheme. 

nel 01-02 to cont

(5) 
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(2) Irrigation Development Monitoring 
 

Panel 01-02 
 
 
 

 
 
 
 
 

Click here to go 
back to Panel 
01-01. 

Click here to go to Panel 
a 01-03 to continue dat

irrigation scheme. 
input for the selected 

(6) 

Enter the data as date 
(date data type,
“dd/mm/y

 
yyy”). 

Type the data as text 
(text data type). 

Type the data as 
numbers (numerical 
data type). 

Enter the data as text 
(text data type). 

Choose one of 
them. 

Check if it is 
required. 

(5) 
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2 Irrigation Database 
 

Panel 01-03 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to go back 
to Panel 01-02. 

(6) 

Enter the data 
as numbers 
(numerical data 
type). 

Choose one. Type the data as 
t (text data 

type). 
tex

Check if it is 
required. 

Enter the data by date 
(date data type). 

Enter the data as 
rs (num

ata type). 

Enter the data as 
numbers (numer
data type). 

ical Choose one. 

(End of the operation) 

numbe
d

Check if it is 
required. 

erical 
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(2) Irrigation Development Monitoring 
 

 Data  

Panel 00  is ex

 Inquiry (p.2-13 to p.2-19)

 
Main Menu (will appear as soon as the database ecuted) 

 

 
l 01Pane  

 
 
 
 
 
 

Click here if you want to 
go back to Panel 00. 

First, choose one of the 
data types 

(2) 

To start usin on 
Development M  
function, click h
to Panel 01. 

(1) 

To start data inquiry, 
click here to go to 
Panel 01-07. 

After choosing inventory survey stage, Data 
Inquiry command button becomes active. In case 
of choosing “Present Condition and the Latest 
Development Plan”, both Data Input and Data 
Inquiry command buttons are activated. 

g “Irrigati
onitoring”
ere to go 

2 - 13 
 



2 Irrigation Database 
 

Panel 01-07 

  

First, choose one of 
the output formats 
from the list. 

Click here to obtain 
further panels 
(Panel 01-08 to 
01-11) for output 
condition setting. 

Click here to go back to 
Panel 01. 

 
 
Panel 01-08 

 
 
 
Panel 01-09 

 

Click here to ob
output with For

tain the 
m 1-1-1. 

Click targe
administra
body using
lists. 

Click here to 
obtain the 
output with 
Form 1-1-2. 

(2) 

(3a) If you 
choose 
Form 1-1-1 

(3b) If you 
choose 
Form 1-1-2 

Click 
target 
administra
tive body 
using the 
lists. 

(In the exam
above, data f

hirrigation sc
under Coast R
be outputted

(3d) If 
you 

m 
1-2-2 

choose 
For

Click her
Panel 01

e to go ba
-07. 

ck to 

 
 
 

Click her
go back to 
Panel 01-07. 

e to Choose “All” to outp
the irrigation schem
under the selected 
administrative body.

ut all 
es 
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emes 
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). 

e 
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.
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Panel 01-10 

  
 
 

anel 01-11
 
P  

  

(3c) If you 
choose 

rm 1-2-1 Fo

Click here to go back to 
Panel 01-07. 

Click here to obtain the 
output with Form 1-2-1. 

Click 
target 
administra
tive body 
u
l
sing the 
ists. 

(3d
choo
Form

) If you 
se 
 1-2-2 

Click target 
administ
body us
lists. 

rative 
ing the 

Click here to 
obtain the 
output with 
Form 1-2-2. 

Choose “All” to output all 
the irrigation schemes 

 selected 
administrative body. 
under the

(In the example shown 
above, data for all the 
irrigation schemes 
under Morogoro Zonal 
Irrigation Office will 
be outputted.) 

 the operation) (End of

 
 

 
 
 
 
 
 
 
 

 

Click here to 
go back to 
Panel 01-07. 
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Form 1-1-1 

Inv
Scheme Digest 

entory Survey 
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Form 1-1-2 

s 
y 

Listed Outline
Inventory Surve
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Form 1-2-1 

Scheme Digest 
Development Monitoring 
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Form 1-2-2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(Original data was arranged in some part for display.) 
 
 
 

Development Monitoring 
Listed Outlines 
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2 Irrigation Database 
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Editing List of Administrative Bodies (p.2-20 to p.2-26) 

anel 00 Main Menu (will appear as soon as the database is executed)
 
P  

 

 
Panel 01 

 
 
 
 
 
 

Click here if you want to 
go back to Panel 00. 

To edit the list of 
administrative bodies, 
click here to go to 
Panel 01-11 

(2) 

To start using “Irrigation 
Development Monitoring” 
function, click here to go 
to Panel 01. 

(1) 

2 - 20 
 



(2) Irrigation Development Monitoring 
 

Panel 01-11 

 

Click here to go back 
to Panel 01. 

Enter the password to allow editing of 
master data. 

After entering the password, click 
here to go to Panel 01-12. 

 
 
Panel 01-12 

 
 

 
 
 
 
 
 

To add/delete a zone or 
edit the list of regional 

 offices, click 
o to Panel 01-13. 

 
irrigation
here to g

To add/delete a
edit the list of regions, 
click here 

 region or 

To add/delete a district or 
edit the list of districts, 
click here 

Click here to go back to 
Panel 01. 

(2) 

(3) 

(4a-1) 

 

(4a-1, 4a-2) 

Refer the 
irrigation GIS to 
confirm the 

es under 

administration! 

schem
the new 

(4a-2) 

Next

 

d a zone 

PagePage 

To ad

 

te

 2-23 

To dele
The operation is the same as
the one for “Zone”. 
 a zone 
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 To add a new zone
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Panel 01-13 
 

 

 
 
 
 
 
 
Panel 01-14

 
 
 
 
 
 
 

 
 
 

 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Click here to go 
ext record. to n

Click here t
to the last 

Click here to go back 
to Panel 01-12. 

Enter the name of the 
zonal irrigation office. 

Click here to jump to the 
first record. 

Click here to go to 
previous record. 

(4a-1) 

Click here to edit 
regions under the 

After checking that the new office has 
not been registered, enter the name. 

Click here to go 
to next record. 

Click here t
the last to 

A new zone was registered 
Click here to add a new zonal 
o jump 
record. 

irrigation office. 

(4a-1) 

zones. 

Select the 
present zone for 
each region 

Sele
which was 

 

ct a zone 

covering before.

Click here to go 
back to Panel 
01-13. 

(End of the operation) 

o jump 
record. 

There are four regions 
under the zone. Three of 
them are shown in the panel. 
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 To delete a zone

Panel 01-13 
  
 
 
 
 
 
 
 
 
 
 
Panel 01-14 
 
 
 
 
 
 
 
 
 
 
 
 
Panel 01-13 
 
 
 
 
 
 
 

 

 

Click here to edit the regions 
under the zone. 

Select the 
present zone 
for each region. 

(4a-2) 

Select the 
zone to be 
deleted. 

Click here to go 
bac
01-13. 

Click here and press “Delete” 
key to delete the record. 

(4a-2) 

(End of the operation) 

A zone was deleted. 

k to Panel 
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(4a-3: Special case)  

stricts and a new region are generated, and also a new zone is formed. 

1) Start with the smallest one, that is, district

Some new di

→  

12Panel 01-  

anel 01-1

 

 

 

 

 

 

P 5 

 

 

 

 

 

 

 

 

 

Panel 01-16 

 

 

 

 

 

 

 

 

 

 

The new district must be put under a 
previous region temporarily, so that 
irrigation er the new 
district can be retrieved from the 
former d

 schemes und

istrict. 

Enter the name of a 
new district. 

Select the present 
district for each 
scheme. 

Select the district which 
was covering the area of 
the new district before. 

Click [Back] to go back 
to Panel 01-15. 

Click here to edit the districts 
under the new region. 

(4a-3) 
-12. to Panel 01

Click [Back] to go back 

Click here to add new districts 

(4a-3) 
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2) Register a new region 

Panel 01-12 

 

 

 

 

 

 

Panel 01-17 

 

 

 

 

 

 

 

 

 

Panel 01-18 

 

 

 

 

 

 

 

 

 

 

 

 

The new region must be put under the 
 z at districts 

under the new region can be retrieved 
old one temporarily so th

from the former region. 

Enter the name of the 
new region. 

Select the present 
region for each 
district. 

Select the region that 
was covering the area of 
the new region before. 

Click [Back] to go back 
to Panel 01-17. 

Click here to edit the districts 
under the new region. 

(4a-3) 

(4a-3) 

Click [Back] to go back 
to Panel 01-12. 

Click here to add a new region 
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3) Register a new zone 

Panel 01-12 

 

 

 

 

 

 

Panel 01-13 

 

 

 

 

 

 

 

 

 

Panel 01-14 

 

 

 

 

 

 

 

 

 

 

 

 

En
ne

ter the name of the 
w zone. 

Select the present 
rict. zone for each dist

Select the zone which 
was covering the area of 
the new zone before. 

Click [Back] to go back 
to Panel 01-13. 

Click here to edit the regions 
under the new zone. 

(4a-3) 

Click [
to Pan

operation) (End of the 

Back] to go back 
el 01-12. 

Click here to add a new zone 

(4a-3) 
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 Preparation of Dataset for Irrigation GIS (p.2-27 to p.2-29) 

soon as the database is executed)
 
Panel 00 Main Menu (will appear as  

 

 
 
Panel 01 

 
 
 
 
 

Click here if you want to 
go back to Panel 00. 

To send dataset to 
“Irrigation GIS”, click 
here. 

(2) 

To start using “Irrigation 
Development Monitoring” 
function, click here to go 
to Panel 01. 

(1) 
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Panel 02 

 
 
 
 
 
 
 
Screen (a) 

 

(2) 

List of irrigation schemes 
appears. 

With the list of irrigation schemes active, click the 
rt the list

Choose 
administrative 
bodies for the 
dataset. 

GIS”. 

Click here if you want to 
go back to Panel 01. Click here to prepare 

dataset for “Irrigation 

(3) 

 

 Excel icon to expo
Excel. 

 of data to Microsoft 
(4) 
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 (4) 
Screen (b) 

 
 

Save the Microsoft E
destination fold

xcel file to the desired 
er of your computer. 

(End of the operation) 
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(3) Reference  Documents

Data Input and Data Editing (p.2-30 to p.2-31) 

Panel 00 Main Menu (will appear as soon as the database is executed) 

 

 
Panel 02 

 
 
 

To start data input, click here 
to go to Panel 02-01. 

Click here to go back 
to Panel 00. 

(2) 

(1) 

To start using 
“Reference Documents” 
function, click here to go 
to Panel 01. 
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Panel 02-01 

Select location 
(library)
documen

 where the 
t is to be 

stored. 

Select classification of 
the document to be 
registered. 

After choosing library and classification, 
l appear. following information wil

 

 

 

Enter name of the document. 

Enter name of the publisher. 

Click here and press “Delete” key to delete 
the record. 

Enter the published year as 4 
digits. 

Choose published month. 

Enter the page number. 

Choose whether the document is 
original or copy. 

Choose the area that the 
document describes. 

Click here to go to 
next record. 

Click here to go to 
the last record. 

Click here to register new 
documents. 

Click here to go back 
to previous record. 

Click here to go back 
to Panel 02. 

The database allocates document code 
number automatically. 

(End of the operation) 

(2) 
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2 Irrigation Database 
 

 

 Data Inquiry (p.2-32 to p.2-34) 

Panel 00 Main Menu (will appear as e is executed)
 

soon as the databas  

 

 
 
Panel 02 

 
 

To start data inquiry, 
click here to go to 
Panel 02-02. 

Click here to go back 
to Panel 00. 

(2) 

(1) 

To start using 
“Reference Documents” 
function, click here to go 
to Panel 01. 
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(3) Reference Documents 
 

Panel 02-02  
 

 
 
 
 

 
 
 
 
 
 

 

Click here to go back 
to Panel 02. 

Choose library, if you want to 
ents 

he selected library. If 
not, you will get the list for all the 

display only the list of docum
stored in t

libraries. 

Choose classification, if you want 
 list of 

documents for one classification. 
t the list for all 

classifications. 

to display only the

If not, you will ge

Enter key wor
want to displa

d by text data, if you 
y only the list of 
at includes the key 

word in the title. If not, you will 
ment titles. 

documents th

get the list of all docu

Enter key word
want to di

 by text data, if you 
splay only the list of 

documents that includes the key 

l get the list for all publishers. 
word in the publisher. If not, you 
wil

Choose contents to display the 
documents list with selected 
contents (one of them must be 
selected). 

Click here to get the results 
(Output Form 2-1) after settin
the inquiry conditions. 

g 
Obtain Output 
Form 2-1 

(End of the operation) 

(2) 
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2 Irrigation Database 
 

Form 2-1 
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(3) Reference Documents 
 

 Label Prepar n (p.2-35 to p.2-39) 

Panel 00 Main Menu (will appear as soon as the database is exe

 atio

 
cuted) 

 

 
Panel 02 

 
 
 

To start preparing 
labels, click here to go 
to Panel 02-03. 

Click here to go back 
to Panel 00. 

(2) 

To start using 
“Reference Documents”
function, click here to go 
to Panel 01. 

 

(1) 
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2 Irrigation Database 
 

Panel 02-03 

 
Click here to go back 
to Panel 02. 

Click here to obtain 
documents label (Output 
Form 2-2). 

Obtain Output Form 
2-2 

(End of the operation) 

(2) 
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(3) Reference Documents 
 

Form 2-2Form 2-2

(3) Reference Documents 
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2 Irrigation Database 
 

 Editing List of Libraries (p.2-38 to p.2-39) 

 
Panel 00 Main Menu (will appear as soon as the database is executed) 

 

 
Panel 02 

 
 
 

To start editing library 
list, click here to go to 
Panel 02-04. 

Click here to go back 
to Panel 00. 

To start using 

function, click h
to Panel

“Reference Documents” 
ere to go 

 01. 

(1) 

(2) 
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(3) Reference Documents 
 

(3) Reference Documents 
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Panel 02-04 

 
 
 
 
 
 
 

 

 

Click here to go to 
next record. 

Click here to go to 
the last record. 

Click here and 
press “Delete” key 
to delete the 
record. 

Enter or edit the name of 
library. 

Click here to register new 
name of library. Please 
make sure that the new 
name of library has not 
been already registered. 

Click here to go back 
to Panel 02. 

Click here to go back to 
previous record. 

Allocate a code for the 
library. The code should 
be unique. 

(End of the operation) 

(2) 
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2 Irrigation Database 
 

(4) Topographic Maps 

 Data Inquiry (p.2-40 to p.2-42) 

 
Panel 00 Main Menu (will appear as soon as the database is executed) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) 

To start using 
“Topographic Maps” 
function, click here to go 
to Panel 03. 
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(4) Topographic Maps 
 

Panel 03 
 

 
Click here to go back 
to Panel 00. Click a command button to 

obtain Panel 03-02 (more 
detail index maps for 
respective area). 

(2) 

(1) 
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2 Irrigation Database 
 
2 Irrigation Database 
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Panel 03-01 Index Map for 1:250,000 Scale Maps 
 

 

 

 

 

 

 

Click here to go back 
to Panel 03-01. 

Click here to obtain 
electronic topographical map 
of the respective area. 

Click here to obtain index map 
for 1:50,000 scale topographic 
maps (the function is under 
construction). 

(2) 
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(5) Version Information 
 

(5) Version Information 

 Version Information (p.2-43) 

 
Main Menu (the main menu will appear as soon as the database is executed) 

 

 
Panel 04 Version Information 

 
Click here to go back 
to Panel 00. 

Click here to obtain 
version information of 
the database. (1) 

(End of the operation) 
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2 Irrigation Database 
 

(6) Maintenance of the Database 

) Daily Maintenance 

ase should be backed up and stored on extern edia (such as external 
hard disk) everyday t of the database program and accumulated data. 
After choosing “quit t e” button in Main Menu (Panel 00), the user should 
copy the database fil t into the external media. Even if the computer is 
totally destroyed, the n be restored to another computer. 

(b) Weekly e 

As time goes on, the d  file size becomes larger and larger. To minimize the 
size of the database, t should compact it once a week, after taking backup

(a

The datab al m
o avoid loss 
he databas

e and past i
database ca

Maintenanc

atabase
he user  

(after completion of daily maintenance). The user can compact the database by 
choosing “Tools” in the menu bar and choosing “Database Utilities” and “Compact 
and Repair Database”, as shown below. 
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3. Irrigation GIS 
 
 

 

Irrigation Development 
Potential Map 

Image of the Irrigation GIS 
 



(1) General 
 

3 Irrigation GIS 

(1) General 

In order to organize the data and information collected during the Master 
Plan study, an Irrigation GIS was prepared mainly based on the materials 
employed for the analysis of water resource potential, land resource 
potential, and socio-economic potential.  This GIS system can be utilized to 
assist with evaluating the irrigation potential of the proposed scheme.  This 
GIS consists of various information on socio-economic conditions, including 
administrative boundaries and road distribution along with protected areas, 
land cover, land units and soil type.  Most of the data is at the national level 
and the accuracy of some data is not satisfactory for regional and district 
level at the present stage.  The Irrigation GIS system should therefore be 
developed as the availability and accuracy of the data increase. 

There are some other GIS data available in the Department of Research and 
Development, Soil Conservation and Land Use Planning Section.  Some of 
those data are also useful for evaluating the irrigation potential of proposed 
schemes.  Outlines on those data were also presented in this manual. 

(2) Structure of GIS 

Arc View (Version 3.2), the most prevalent GIS software, was selected for 
the operation of the system.  All the information collected during the study 
is stored in the structure shown below. Details are shown on the following 
page.   

 

Main directory Sub directory Files 

C:¥irrigation_gis ¥national 

 ¥zonal 6 zones 

 ¥regional 20 regions 

 ¥district 100 districts 

 ¥legend 

agro-ecological zone, protected area,  

land cover, land unit, soil type,  

rainfall, river, lakes,  

road network, railway network, 

water potential, land potential,  

socio potential, irrigation potential, 

irrigation scheme 
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3 Irrigation GIS 

Table   Structure of Irrigation_GIS
Main Directory Sub-directories File Name Type Contents
C:\irrigation_gis \national \tz_border .shp National border

\tz_regions .shp Regional border
\tz_regheadq .shp Regional Headquarter
\tz_dist .shp District border
\tz_road .shp Road network
\tz_railway .shp Railway network
\tz_lakes .shp Lakes
\tz_rivers .shp River
\tz_rain .shp Rainfall
\tz_agroecologicalzone .shp Agro-ecological zone
\tz_protectedarea .shp Protected area
\tz_nationalparks .shp National park
\tz_forestreserves .shp Forest reserve
\tz_gamereserves .shp Game reserve
\tz_conservationareas .shp Conservation area
\tz_landcover .shp Land cover
\tz_landunits .shp Land unit
\tz_soiltype .shp Soil type
\tz_waterpotential .shp Water potential for irrigation
\tz_landpotential .shp Land potential for irrigation
\tz_sociopotential .shp Socio potential for irrigation
\tz_irrigationpotential .shp Irrigation potential
\tz_irrigationscheme .shp Irrigation Scheme

\zonal\zone \zone_border .shp Zonal border
\zone_regheadq .shp Zonal Headquarter
\zone_region .shp Region border
\zone_road .shp Road network
\zone_railway .shp Railway network
\zone_lakes .shp Lakes
\zone_rivers .shp River
\zone_rain .shp Rainfall
\zone_agroecologicalzone .shp Agro-ecological zone
\zone_protectedarea .shp Protected area
\zone_nationalparks .shp National park
\zone_forestreserves .shp Forest reserve
\zone_gamereserves .shp Game reserve
\zone_conservationareas .shp Conservation area
\zone_landcover .shp Land cover
\zone_landunits .shp Land unit
\zone_soiltype .shp Soil type
\zone_waterpotential .shp Water potential for irrigation
\zone_landpotential .shp Land potential for irrigation
\zone_sociopotential .shp Socio potential for irrigation
\zone_irrigationpotential .shp Irrigation potential
\zone_irrigationscheme .shp Irrigation Scheme  
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(2) Structure of GIS 
 

 (continued) 

Main Directory Sub-directories File Name Type Contents
C:\irrigation_gis \regional\region \region_border .shp Regional outer border

\region_regheadq .shp Regional Headquarter
\region_dist .shp District border
\region_road .shp Road network
\region_railway .shp Railway network
\region_lakes .shp Lakes
\region_rivers .shp River
\region_rain .shp Rainfall
\region_agroecologicalzone .shp Agro-ecological zone
\region_protectedarea .shp Protected area
\region_nationalparks .shp National park
\region_forestreserves .shp Forest reserve
\region_gamereserves .shp Game reserve
\region_conservationareas .shp Conservation area
\region_landcover .shp Land cover
\region_landunits .shp Land unit
\region_soiltype .shp Soil type
\region_waterpotential .shp Water potential for irrigation
\region_landpotential .shp Land potential for irrigation
\region_sociopotential .shp Socio potential for irrigation
\region_irrigationpotential .shp Irrigation potential
\region_irrigationscheme .shp Irrigation Scheme

\district\region\district \district_border .shp District outer border
\district_road .shp Road network
\district_rivers .shp River
\district_rain .shp Rainfall
\district_agroecologicalzone .shp Agro-ecological zone
\district_protectedarea .shp Protected area
\district_landcover .shp Land cover
\district_landunits .shp Land unit
\district_soiltype .shp Soil type

\legend \rain.avl .avl Legend for rainfall
\agroecologicalzone.avl .avl Legend for agroecologicalzone
\landcover.avl .avl Legend for land cover
\soiltype.avl .avl Legend for soil type
\waterpotential.avl .avl Legend for water potential
\landpotential.avl .avl Legend for land potential
\sociopotential.avl .avl Legend for socio potential
\irrigationpotential.avl .avl Legend for irrigation potential  
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3 Irrigation GIS 

(3) Operation of GIS 

(a) Basic operation of GIS (Arc View) 

(i) Add Theme to the View Screen 

 Add Theme 

When the “theme” is added, Arc View accesses the database and shows the 
“theme” on the view screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) Click “Full 

Screen” button 

to enlarge View1 

(2) View1 will be 

opened 

(1) Click “New” to 

open View 

Screen 

 

(4) View1 will be 

enlarged 
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(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

(5) Click “+” button 

or select “Add 

Theme” from 

View Menu 

 

 

 

 

 

 

 

 

 

(6) Select target 

“Theme” from 

the directory 

where the shape 

files are stored 

(8) When the target 

“Theme” is 

selected, click 

“OK” 

 

 

 

 

 

 

(9) Confirm the 

target “Theme” 

is located at the 

legend position

of the View 

Screen 
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3 Irrigation GIS 

 

 

 

 

 

(10) Click the check 

box of “Theme” 

to show the 

“Theme” on the 

View Screen 

 

 

 

 

 Utilization of readily available legend 

For some themes, such as land cover and soil type, the ready-made legend 
can be utilized as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(6)

(1) Double click 

“Theme” added 

(Tz_soiltype for 

example) 

(2) Click “Load  in 

Legend Edi or 

window 

”

t

(3)

(4)

(5)
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 Select 

“soiltype.avl” in 

Load Legend 

window 
 Click “OK” 
 Click “OK” in 

Load Legend 

window 
 Click “Apply” in 

Legend Edi or 

window 

t



(3) Operation of GIS 
 

Add Another “Theme” 

In addition to Tz_soiltype.shp, Tz_regions.shp can be added to the same 
view screen in order to show the border of regions on the map of soil type. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Click the check 

box of “Theme” 

to show the 

“Theme” on the 

View Screen 

(3)

 

(4)

(5)

(6)

(7)

(1) Tz_regions.shp 

will be added in 

the same manner 

mentioned above 
 Double click 

“Theme” to get

legend editor 
 Double click 

“Symbol” to edit 

legend 
 Select 

“Foreground” 

and click white 

and X to show 

only border 

 Select “Ou line” 

and click red to 

show the border 

in red color 

t

 

 Click “Apply” to 

show the result

on screen 
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3 Irrigation GIS 

 Arrangement of Themes 

Add another theme of Tz_nationalparks.shp and arrange themes. 

 

 

 

 

 

 

 

 

 

(1)

(2)

 

 

 

 

 

 

 

 

 

(3)

 

 

 

 

 

 

(4)
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 National parks 

will be shown on 

the boundary of 

the region 
 In order to show 

the boundaries 

of the region, 

activate 

Tz_regions.shp 

and drag to the 

top of the list 

 Boundary of the 

region is shown 

on National 

Parks and 

National Parks

are shown on 

Soil Types 

 

 Display can be 

turned off for 

unnecessary 

theme(s) by 

removing the 

check mark from 

check box 



(3) Operation of GIS 
 

 Other view controls such as zoom in and zoom out 

The following buttons can be used to zoom in, zoom out and for other 
functions. 

- Zoom In 

- Zoom Out 

- Zoom to Full Extent 

- Zoom to Active Theme(s) 

- Zoom to Selected 

- Zoom In 

- Zoom Out 

- Zoom to Previous Extent 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Click “Zoom In” 

button and 

select the area 

to be enlarged, 

for example, 

Coast Reg on  i   

(2) The selected 

area will be 

enlarged, for 

example, to show 

the details of 

Coast Reg on  i   

(3) Return to the 

previous extent 

by clicking 

“Zoom to Full 

Extent” or 

“Zoom to 

Previous Extent” 
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3 Irrigation GIS 

To show the distribution of national parks in different regions, the following 
arrangement can be carried out. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Remove check 

mark from soil 

type   

(2) Activate 

National Parks

Theme   

 

(3) Click “Zoom to 

Active Theme   ”  

(4) Return to the 

previous extent 

by activating the 

regions theme

and clicking 

“Zoom to Full 

Extent”   
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(3) Operation of GIS 
 

 (ii) Theme Tables 

 Open Theme Table 

Theme table can be shown on screen by clicking “Open Theme Table” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2)

(3) Attributes of 

Tz_regions.shp 

(1)

 

(5)

(6)

(7)

(8)
 Activate the 

theme for 

example 

Tz_regions.shp
(4) Attributes of 

Tz_regions.shp 

will be listed 

 Click “Open 

Theme Table” 

button 

will be opened 
 Click any polygon 

in the table  
 

 The selected 

polygon will be

highlighted in 

the map  
 More than one 

polygon can be 

selected with 

Shift Key  

 

 Selected 

polygons can be 

cancelled by 

clicking “Select 

None” button  
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3 Irrigation GIS 

 Close Theme Table 

Theme table can be closed by clicking the close button of the table window. 

 

 

 

 

 

 

 

 

 

(iii) Project 

Change View Name 

View name can be changed from the temporary name of “View1”. 

 

 

 

 

 

 

 

 

 

 

(1) Select 

“Properties” 

from View Menu 

(2) Type appropriate 

name instead of 

View1  

 

 

(3) “Soil Type and 

National Parks” 

for example  
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(3) Operation of GIS 
 

Save Project 

Created set of data can be stored as Project Files. 

 

 

 

 

 

 

 

 

 

(2) Select suitable 

directories 

(3) Type appropriate 

name instead of 

Proj1 

(1) Select “Save 

Project As” 

from File Menu 

 

 

(4) ” lesson1” for 

example 

 

 

 

 

Close Project 

 

 

 

 

 

 

 

 

 

 

(1)

 

 Close View by 

clicking close 

button of view

screen 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Confirm “View 

Name” and 

“Project Name”  

(3) Select “Exit” 

from File Menu  

(4) Select “No  if 

there is no 

change 

”

Open Project 

Once the project file is saved, this project file can be opened by simply 
double clicking the icon of this file. 
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(3) Operation of GIS 
 

(b) Plotting the Location of a Proposed Irrigation Site on the GIS 

(i) Collect coordinate data of proposed irrigation site by GPS 

Since the unit of available map data is decimal degree, the location of the 
proposed irrigation site should be collected in the form of degree and minute 
(dddomm.mmm’).  If coordinates for several points on the perimeter of the 
site are obtained, polygon data can be created instead of point data for the 
proposed site. 

 

Polygon data 

Point data Perimeter of the site  

 

 

 

 

 

 

(ii) Prepare DBF file of proposed irrigation site 

Coordinate data collected should be recorded as an Excel file that also 
includes other data for the proposed site.  Otherwise, the necessary data 
including coordinate data should be derived from the “Irrigation Database” 
mentioned previously.  Coordinate data should be converted to decimal 
degree and then this file should be saved as DBF file (see sample file: 
Mkuranga_Scheme.dbf). 

 

 

 

 

  

 

 

 

 

(2) Sava as: 

Save as Type = 

DBF4 

(1) Conversion  :

lat_dec= 

-1*(lat_d+lat_m/60) 

lon_dec= 

(lon_d+lon_m/60) 
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3 Irrigation GIS 

(iii) Add DBF file on GIS 

Open Arc View and add DBF file prepared by clicking the button as shown 
below.  Target file (Mkuranga_Scheme.dbf) will then be added to the Table 
list of Arc View and the contents of dbf file will be shown.  

 

 

 

 

 

(iv) S
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(1) Click “Table”
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) The contents of 

the file will be 

shown on screen

” 

(1) Target file will 

be added in 

Table list 

how Point Data o

Open new view a
function of “Add E

 

 

 

(2) Click “Add
 

(3)  

 

n Screen 

nd show the point data of the targe
vent Theme” from View window in the 
(4) Click “OK”
 Select target

file 
t file by using the 
following manner. 



(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

w 

(2) Select “Add Event Theme” 

from View Menu 

 

 

 

 

 

 

 

 

 

(1) “Add Event 

Theme” window 

will be opened  

 

(3)

(2)  

 

(4)  

 

 

 

 

 

 

 

 Select “lat_dec”

as Y field 
 Select “lon_dec” 

as X field 
 Select “Target

Table” as Table
 (5) Click “OK”
(1) Open New Vie
 

 

 

Point data of the 

target file will be 

shown on View 

Window 
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3 Irrigation GIS 

(v) Preparation of Polygon Data 

Prepare DBF file for the point data along the perimeter of the scheme and 
show those point data on screen through the same process described in 
preceding steps (i) to (iv), (see sample file: Kisere.dbf). 

 

 

 

 

 

(1) Data Input 

(2) Data Conversion 

(3) Save as DBF4 

 

 

 

 

 

Same Process of (i) to (iv)  

 

 

 

 

 

 

Point data of the 

target file will be 

shown in the View 

Window 

 

 

 

 

 

Create Polygon data by connecting the point data by using the function of 
“New Theme” (Feature type is Polygon) in the following manner. 
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(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

(2) Select “New 

Theme” 

(1) Open View Menu 

 

 

 

 

 

 

 

 

 

 

(2) Click “OK” 

(1) Select “Polygon” 

as Feature Type 

 

 

 

 

 

 

 

 

 

(1) Specify 

appropriate 

directories and 

file name 

(2) Click “OK” 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

Shape file is 

automatically shown 

and ready for 

editing 

 

 

 

 

 

 

 

 

 

 

Select “Draw 

Polygon” from 

Drawing Menu 

 

 

 

 

 

 

Draw polygon by 

clicking point data 

one by one and 

complete by double 

click 

 

 

 

 

3 - 20 
 



(3) Operation of GIS 
 

  

  

 

 

 

 

 

 

 

Stop editing by 

selecting “Stop 

Editing” from 

Theme Menu 

 

 

 

 

 

 

 

 

 

 

Click “Yes” for save 

Edit 

 

 

 

 

 

 

 

 

 

 

(2)

(1)
 Shape file of 

Polygon is 

successfully 

created 
 Remove check 

from DBF theme 

to show only the 

polygon on 

screen 
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3 Irrigation GIS 

(vi) Area Size Calculation of Polygon Data 

In order to calculate the area size of a newly created polygon, the map 
should be projected to give proper length.  The area size will then be 
calculated in the following manner. 

 

 

 

 

 

 

 

 

 

(1) Select 

“Properties” 

from View menu 

(2) “View 

Properties” will 

be shown 

(3) Select “me ers” 

as map unit 

t

 

 

 

 

 

 

 

 

 

 

(1) Select “meters” 

as distance unit 

(2) Click 

“Projection”  
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(3) Operation of GIS 
 

 

 

 

(1) “Projection 

Properties” will 

be shown 

 

 

 

(2) Select 

“UTM-1983” as 

Category 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Select “Zone 36” 

for the area of 

longitude 30-36 

or “Zone 37” for 

the area of 

longitude 36-42 

as Type 

(2) Click “OK” 

(2) Click “OK” 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

(1) Activate shape 

file of target 

polygon 

(2) Open theme 

table of target

polygon 

 

 

 

 

 

 

 

 

 

 

 

(1) Attributes of 

target polygon 

will be shown 

(2) Select “Start 

Editing” from 

Table menu 

 

 

 

 

 

 

 

 

 

(1) Select “Add

Field” from Edit 

menu 
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(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

(1) “Field Definition” 

will be shown 

(2)  

(3)

 

 

 

 

 

 

 

 

 

 

(1)

(3)

(4)

 

 

 

 

 

 

 

 

 

(1)

(2)

 

 Type the name

of the field 

(“Area” for 

example) 
(4) Click “OK” 

 Arrange width 

and decimal if 

necessary 

 New field “Area” 

will be added 

 Confirm “Area” 

field is activated 

 Click “Calculate” 

 “Field Calculator” 

will be shown 

(3) Click “OK” 

 Type 

[Area]=[Shape].

ReturnProjected

(av.FindDoc 

(“View1”). 

GetProjection). 

ReturnArea 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

(1) The result of 

calculation is 

now shown in the 

field of area 

(Unit is square

meter) 

 

 

 

 

 

 

 

 

 

 

 

(1) Select “Stop 

Editing” from 

Table menu 

 

 

 

 

 

 

 

 

 

(1) Click “Yes” to 

stop editing and 

finish the work 
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(3) Operation of GIS 
 

(c) Superposition of Thematic Maps on GIS 

(i) General features such as administrative boundaries, rivers and roads 

On the point or polygon data of irrigation sites, various themes on general 
features such as administration border, river and road can be superposed as 
a background. 

 

 

 

 

 

 

 

 

 

 Legend can be further adjusted by using various palette as shown below. 

(1) Add various 

shape files of 

border, river 

and road 

(2) Adjust the 

sequence of 

themes in order 

to obtain 

appropriate view 

 

 

 

 

 

 

 

 

 

(1) Double click the 

target theme 

(2) Double click the 

target Symbol 

(3) Adjust the 

legend by using 

various palette 

(4) Click “Apply” 

 

 

 

 

 

Note: Completed view can be saved by giving view name 

in “View Properties Window” as shown in the right. This 

window can be shown on screen by selecting “Properties” 

from View Menu. Furthermore, the whole project 

including many views can be saved by selecting “Save 

Project As” from File Menu. 
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3 Irrigation GIS 

(ii) Protected areas such as national parks, forest reserves, game reserves and 
conservation areas 

Add the shape file of protected areas in order to know whether some of the 
proposed scheme is located within or in the vicinity of a protected area or 
not. 

 

 

 

 

 

 

 

 

 

 

 

(1) Add shape file 

(protectedarea) 

(2) Adjust sequence 

of theme and 

legend 

(3) In this sample, 

one of the 

schemes is 

located in the 

vicinity of  a 

Forest Reserve 

(iii) Natural conditions such as rainfall and agroecological zones 

Add the shape file of rainfall and agroecological zones in order to investigate 
the meteorological and agroecological characteristics of the proposed 
irrigation site.  

 

 

 

 

 

 

 

 

 

 

(3) In this sample, 

all schemes 

belong to the 

same rainfall 

zone of 

1000~1200mm 

(2) Adjust sequence 

of theme and 

legend 

(1) Add shape file 

(rainfall) 
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(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) In this example, 

only one scheme 

belongs to C5 

and all the other 

schemes belong 

to C2 

Note: Agroecological zone provides various information on soil/topography, growing period, 

major farming systems and others.  These information might be useful for agricultural 

planning such as suitable crops to be cultivated, cropping season and farming practices. 

Descriptions of agroecological zones are available in the Master Plan Report. 

(2) Adjust sequence 

of theme and 

legend 

(1) Add shape file 

(agroecological) 

 

 (iv) Land related information such as land cover, land unit and soil type 

Add land related shape files in order to investigate the land and topographic 
characteristics of the proposed irrigation site. 

 

 

 

 

 

 

 

 

 

 

(3)

(2)

(1)

 

 

No

ba

the
 Add shape file 

(land cover) 
 Adjust sequence 

of theme and 

legend 
 In this sample, 3 

schemes are in 

grassland and 

one is in 

woodland 
te: The shape file of land cover gives the detailed information on land cover and land use 

sed on the Landsat TM scenes obtained during 1994 and 1996.  Detailed information on 

 distribution of land cover in each District is available in the Master Plan Report 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Adjust sequence 

of theme and 

legend 

(3)

No

con

ava

(1) Add shape file 

(land unit) 

 

 

 

 

 

 

 

 

 

 

(1)

(2)

(3)

 

 

 

 

 

 

No

cla

ava

198

the
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 In this sample, 3 

schemes are in 

CT and one is in

CH1

 

 

te: The shape file of land unit gives topographic information such as altitude and slope 

ditions together with drainage and salinity situation.  Descriptions of each land unit are 

ilable in the Master Plan Report. 

 Add shape file 

(soil type) 

 Adjust sequence 

of theme and 

legend 

 In this sample, 2 

schemes are in 

Arenosols and 

two schemes are 

in Cambisols  

te: The shape file of soil type gives general information of major soil types based on the 

ssification of the FAO/UNESCO Soil map.  The key soil properties of each soil type are 

ilable in the Master Plan Report.  More detailed soil survey was carried out during the 

0s by the Department of Research and Development.  Soil maps were prepared based on 

se survey works and these maps are now being degitized. 



(3) Operation of GIS 
 

(v) Utilization of readily available legend 

An appropriate legend can be arranged according to requirements.  For some 
themes such as land cover and soil type, however, a ready-made legend can 
be utilized as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Double click 

“Theme” added 

(land cover for 

example) 

(2) Click “Load  in 

Legend Edi or 

window 

”

t

(3)

(4)

(5)

(6)

 

 

 

(7)

 

 

 Select 

“Landcover.avl” 

in Load Legend 

window 
 Click “OK” 
 Click “OK” in 

Load Legend 

window 
 Click “Apply” in 

Legend Edi or 

window 

t

 The ready-made 

legend such as

“Landcover.avl” 

will be applied 
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3 Irrigation GIS 

(vi) Utilization of “Zoom In” function 

For data that has high resolution, such as land cover, the “Zoom In” function 
can be effectively utilized to observe the details of the specific site in the 
following manner.    

 

 

 

 

 

 

 

 

 

 

(1) Click “Zoom In” 

button 

(2) Enclose the 

specific area of 

interest 

 

 

 

 

Selected area is 

enlarged and more 

detailed information 

will be obtained 

 

 

 

To go back to the original position, the “Zoom to Active Theme” 

button can be used.  Prior to clicking the button, the target 

theme should be activated by clicking the theme. 

(1) Click targe  

theme 

t (2) Click “Zoom to Active 

Theme” button 

 

 

 

 

 

In this example, it is 

clear that the site 

is located just 

adjacent to a swamp 

area 
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(3) Operation of GIS 
 

Polygon data of the scheme can be added to observe the details of 
surrounding land cover and distances can also be measured in the following 
manner. 

 

 

 

 

 

(1)  

(2) Click “Zoom In” 

button 
(3) Enclose the area 

around polygon 

data 

(5)

(6)

 
function. 

 

 

 

 

 

Note: In order to get proper d

measurement, “View Properties” should be a

prior to the measurement. “View Properties” 

can be shown on screen by selecting “Prop

from View Menu. Select “decimal degrees” 

Units and select “meters” as Distance Units 

Properties Window as shown at right. 
 Click “Measure” 

button 
 Add prepared

Polygon data 
 

 

 

 

 

 

 

 

 

 

 

 

(4) In this example, 

it is clear that 

the site is 

located in 

glassland but 

there is 

bushland and 

woodland in 

between the 

road and the 

site. 

The distance 

between the two 

points can be 

measured by the 

using “Measure” 
 

 

 

(7) The distance is 

shown at the 

bottom 
 Click one end and

drag to the 

other end 

 

istance 

djusted 

window 

erties” 

as Map 

in View 
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3 Irrigation GIS 

(d) Printout of appropriate layout 

(i) Preparation of layout 

The data obtained through the Irrigation GIS should properly be printed out 
in order to distribute them to regional and district levels.  A layout 
appropriate to the requirement can be prepared by using “Layouts” function 
as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Assign the

location of view

on layout  

 

 

(3)

(1) Click “Layouts” 

and click “New” 

New layout window 

will be opened 

(1)

 

 

(2)

(5) Click “O 

 

 

 

 

Note: It is recommended to set up the “Printer to be

arrangement.  For such setting up, “Print Setup” can

can be used for large size papers such as A0 and A1. 
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 Select “View 

Frame”  
 Click “View 

Frame” to get

view on layout
(4) Select target view, 

protected area for 

example 
 “View Frame 

Properties” 

window will be 

opened 
K”  

 Used” and “Paper Size” prior to layout 

 be selected from File Menu.  Plotter 



(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

 

(3)

(2)

(1)

 

 

 

 

 

 

 

 

(2)

(1)

 

 

 

 

 

 

(2)

(1)
 Select “Legend 

Frame” to get 

legend on layout
(5)  

(4) Select target view  

 Assign the

location of 

legend on layout 

 

 

 “Legend Frame

Properties” 

window will be 

opened 
 Assign the

location of scale 

bar on layout  

 

 

(5)

 

 Assign the

location of title 

on layout  

 

(5)

 

 Click “OK” 
 Select “Scale Bar

Frame” to get 

scale bar 
(4) Select target view 

and arrange style, 

units and interval 
 

 

 

(3) “ScaleBar Frame 

Properties” 

window will be 

opened 

 
 Click “OK” 
 Click “Text” to

give Title on 

layout 
 

(4)

 

 

 

 

(3) “Text 

Properties” 

window will be 

opened 
 Type “Title” and 

arrange alignment
 Click “OK” 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

 

(2)

(3)

(1) Select “Print” 

from File Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

No

ex

Me

Pow

“Ex

the
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 The layout

prepared will be 

printed out  

 

 After completing print out, all the 

work can be saved by selecting “Save  

Project” or “Save Project as” from 

File Menu 

te: Instead of printing through the “layouts” function, any views or layouts can be 

ported to a specified folder in different file formats such as Placeable WMF, Windows 

tafile, Windows Bitmap, JPEG and others.  Such files can easily be pasted into Word, 

erPoint and other files.  For exporting, activate the target view or layout and select 

port” from File Menu.  Export window will be opened.  Specify the directory, type 

 file name and select the file type as shown below. 

(4) Click “OK” 

(3) Select the file 

type 

(2) Type out the file 

name 

(1) Specify the 

directory 



(3) Operation of GIS 
 

 (ii) Add graticule to layout 

Graticules can be added to the layout by activating the function of 
“graticules and measured grids” in “Extension” in the following manner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1)

 

(2)

(3)

(1)

(4)

(3)

(2)

 

 

 

 

 Select 

“Extensions” 

from File menu
 Put check mark 

on “Graticules 

and measured 

grid” and click 

OK 
 

 “Graticules and 

Grids” button 

will be created 

in the menu bar
 Click “Graticules 

and Grids” 

button 
 

 

 Select graticule 

or measured grid

and click “Next” 
 Select the 

target view 

frame 
 Confirm the 

name of target

view frame 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Adjust all 

settings such as 

intervals, line 

width, line color, 

label font and 

label size 

(2) Click “Next”  

(2) Click “Preview”  

(1) Adjust view 

frame border 

such as line color 

and line style 

 

 

 

(1) Click “Finish” 

when OK 
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(3) Operation of GIS 
 

 

 

 

Graticule is 

successfully added 

to the layout 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3 - 39 



3 Irrigation GIS 

(e) Other useful functions 

(i) Dissolve features based on an attribute 

In case of the modification of the administration boundaries, for example, 
the function “dissolve features based on an attribute” is needed.  This 
function can be operated after activating the Geoprocessing in the extension 
menu.  Following is an example procedure to create a new shape file for a 
new region. 

 

 

 

(1)

 

 

 

 

 

(2)

 

 

 

 

 

 

 

 

 

 

 

(1)

(2)

(3)
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 Select 

“Extensions” 

from File menu
 Put check mark 

on 

“Geoprocessing” 

and click OK 

 
 Add the shape

file of target 

region 
 Open theme 

table 

 Select “Start 

Editing” from 

Table menu 



(3) Operation of GIS 
 

 

 

 

(1)

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1)

(2)

(3)

(1)

(2)

(3)

 

 Select “Add

Field” from Edit

menu 

 

 
 “Field Definition”

box will be 

shown  
 Type out the 

field name and 

select suitable 

type  
 Click “OK”   

 

 

 New Field is 

added to the

ThemeTable 
 Type out the new 

region name  

 Select “Stop 

Editing” from 

Table Menu 
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3 Irrigation GIS 

 

 

 

 

 

 

 

 

 

(1) Select “Yes” to 

stop editing  

(2) Hide the Theme 

Table  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Select 

“Geoprocessing 

Wizard” from 

View menu 

(1) Geoprocessing 

Wizard will be

shown  

 

(2) Select “Dissolve 

features based 

on an attribute”  

(3) Click “Next”  

 

3 - 42 
 



(3) Operation of GIS 
 

 

 

 

 

 

 

 

 

 

 

(1)  

(2)

(3)

(4)

 
(1)

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1)

(2)

(3)

 

 Select theme to

dissolve 

(Arusha_dist) 
 Select an

attribute to 

dissolve (New 

Region)  

 

 

 

 Specify the

output file 
 Click “Next”  

 Click “Finish” 

 New shape file 

will be shown 

 Confirm the 

attribute of new 

shape file by 

showing the 

Theme Table 

 Select Manyara 

3 - 43 



3 Irrigation GIS 

 

 

 

 

(1) Select “Convert 

to shapefile” 

from Theme 

menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1)

 

(3)

(2)

 

 

 

 

(1)
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 Type out “File 

Name” 
 Adjust 

Directories
 Click “OK” 

 Click “Yes” to 

add shape file as 

theme to the 

view 



(3) Operation of GIS 
 

 

 

 

 

(1) Shape file of new 

region is shown 

as theme to the 

view 

 

 

 

 

 

 

(ii) Clip one theme based on another 

The function “clip one theme based on another” is then needed to complete 
the modification.  Following is the sample process to clip Manyara region 
based on Arusha region. 

 

 

 

 

 

 

 

 

 

 

(1) Add 

Arusha_landcover  

as input theme 

and 

Manyara_border 

as clip theme 

(2) Select 

“Geoprocessing 

Wizard” from 

View menu 
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3 Irrigation GIS 

 

 

 

(1) Select “Clip one 

theme based on 

another” 

 

 
(2) Click “Next” 

 

 

 

 

 

 

 

(1)

Arusha_landcover 

 

 

 

(2)

 

 

 

(3)

Manyara_landcover 

 

 
(4) ” 

 

 

 

 

 

 

 

 

 

(1)
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 Click “Finish
 Select input 

theme to clip 
 Select clip 

theme 

Manyara_border
 Specify the 

output file 
 Manyara_landcover 

will be shown in

the view 

 



(4) Other GIS Data 
 

(4) Other GIS Data 

(a) Department of Research and Development 

Various GIS data are available in the Department of Research and 
Development.  Data on agro-ecological zone utilized in the current Master 
Plan Study were obtained from this source.  Under the Department of 
Research and Development, GIS data are mainly handled by three sections: 
the GIS Laboratory in Kilimo 2 (Dar Es Salaam) and the Agricultural 
Research Institute in Mlingano (Tanga) and in Naliendele (Mtwara).   

The department is now keen to prepare GIS data on farming system zones.  
This work is being implemented zone by zone and the work has been 
completed for five of the seven zones in the country as shown below.  The 
detailed descriptions such as physiography, major soils, precipitation, land 
cover, major crops, soil fertility management, socio-economic characteristics, 
constraints and opportunities are given for each farming system zone.  This 
information might be useful for evaluating the irrigation potential of a 
proposed site. 

- Eastern Zone (Tanga, Coast, Morogoro, Dar): Completed, 
- Southern Zone (Mtwara, Lindi, +Tunduru): Completed, 
- Southern Highland (Mbeya, Iringa, Rukwa, Ruvuma-Tunduru): Completed, 
- Western Zone (Tabora, Kigoma): Completed, 
- Central Zone (Dodoma, Singida): Completed, 
- Northern Zone (Arusha, Kilimanjaro): In progress, and 
- Lake Zone (Mara, Mwanza, Kagera, Shinyanga): In progress. 

Detailed soil survey has been carried out under various projects including 
Regional Integrated Development Program by World Bank (Tabora, Lindi, 
Mtwara, Coast, Dar, Kilimanjaro), Regional Master Plan by the Government 
(Tanga, Mbeya, Rukwa, Iringa), Capital Development Authority (Dodoma) and 
National Soil Service during 1980s.  Soil maps were prepared based on these 
survey works and these maps are now being degitized by the Department of 
Research and Development.   

The following GIS data are also available at the national level. 

- Soil and Terrain: Soil type, Altitude, Erosion hazard, 
- Annual Rainfall: More than 30 years data, 
- Hydrology: Distribution of lakes and rivers, and 
- Land Cover/Use: Based on Landsat TM obtained during 1994 and 1996. 
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3 Irrigation GIS 

(b) Soil Conservation and Land Use Planning Section 

Various GIS data are also available in the Soil Conservation and Land Use 
Planning Section.  Most of these data are the area focused detailed and 
focused on specific areas, so those will be useful for evaluating the potential 
of proposed sites for irrigation development.  Data available at present are 
as follows; 
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 c
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Ra
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Co
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Ra
in

fa
ll 

Ra
in

fa
ll 

st
at

io
ns

 

Lake Victoria Basin o o o o o o          
(District) Bariadi o o o o o o          
(District) Biharamlo o o o o o o          
(District) Bukoba o o o o o o          
(District) Bunda o o o o o o          
(District) Geita o o o o o o          
(District) Kahama o o o o o o          
(District) Karagwe o o o o o o          
(District) Kwimba o o o o o o          
(District) Magu o o o o o o          
(District) Maswa o o o o o o          
(District) Meatu o o o o o o          
(District) Misungwi o o o o o o          
(District) Muleba o o o o o o          
(District) Musoma o o o o o o          
(District) Mwanza o o o o o o          
(District) Ngara o o o o o o          
(District) Ngorongoro o o o o o o          
(District) Serengeti o o o o o o          
(District) Shinyanga o o o o o o          
(District) Tarime o o o o o o          
(District) Ukerewe o o o o o o          
(Catchments) Duma o o o     o        
(Catchments) Grumeti o o o     o        
(Catchments) Kagera o o o     o        
(Catchments) Mara o o o     o        
(Catchments) Mbalagati o o o     o        
(Catchments) Simiyu o o o     o        
(Catchments) Smithsouth o o o     o        
(Catchments) Suguti o o o     o        
Tanga Region x   x x x   x x      
Handini District o   o o o o  o  o     
Kilosa District o   o o o o  o   o o   
Morogoro District   o o o       o o o o 

Note: o for available data in UTM system, x for available data in decimal degrees 
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(5) Recommendations 
 

(5) Recommendations 

Various GIS data are available in different Departments and Sections under 
the Ministry of Agriculture and Food Security as mentioned above.  Each 
Department and Section is so far establishing the data system according to 
its own strategy.  Map data are prepared, for example, by UTM system on 
the one hand and by Decimal Degree on the other.  The data of decimal 
degree need conversion for superposition on UTM data.  In order to avoid 
such inconveniences, all GIS data should be managed in a more integrated 
manner.  Furthermore, it is recommended to upload the data system to the 
Internet through Arc-IMS (Internet Map Server) as a future program for 
effective data sharing.  Under data sharing through the Internet, data can 
be shared by various parties even they have no GIS software. 
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